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Notice to Customers
Contact your local dealer for technical assistance. To find the authorized dealer near you, 
call or write us at:

Hemisphere GPS 
4110 9th Street S.E. 
Calgary, Alberta, Canada T2G 3C4

Telephone number: 
Fax number: 
E-mail address:

(403) 259-3311 
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Warranty Notice

Covered Products
This warranty covers all products manufactured by Hemisphere GPS (the "Products").

Hemisphere GPS Limited Warranty
Hemisphere GPS hereby warrants solely to the end purchaser of the Products, subject to the 
exclusions and procedures set forth herein below, that the Products sold to such end 
purchaser shall be free, under normal use and maintenance, from defects in material and 
workmanship for a period of 12 months from delivery to such end purchaser. Repairs and 
replacement components are warranted, subject to the exclusions and procedures set forth 
below, to be free, under normal use and maintenance, from defects in material and 
workmanship for 90 days from performance or delivery, or for the balance of the original 
warranty period, whichever is greater. 

Purchaser's Exclusive Remedy
The end purchaser's exclusive remedy under this warranty shall be limited to the repair or 
replacement, at the option of Hemisphere GPS, of any defective Products or components 
thereof. The end user shall notify Hemisphere GPS or a Hemisphere GPS approved service 
center immediately of any claimed defect. Repairs shall be made through a Hemisphere GPS 
approved service center only. 

Exclusions
Hemisphere GPS does not warrant damage occurring in transit or due to misuse, abuse, 
improper installation, neglect, lightning (or other electrical discharge) or fresh/salt water 
immersion of Products. Repair, modification or service of Hemisphere GPS products by any 
party other than a Hemisphere GPS approved service center shall render this warranty null 
and void. Hemisphere GPS does not warrant claims asserted after the end of the warranty 
period. Hemisphere GPS does not warrant or guarantee the precision or accuracy of 
positions obtained when using Products. Products are not intended for primary navigation or 
for use in safety of life applications. The potential accuracy of Products as stated in 
Hemisphere GPS literature and/or Product specifications serves to provide only an estimate 
of achievable accuracy based on:

• Specifications provided by the US Department of Defense for GPS Positioning,
• DGPS service provider performance specifications.

Hemisphere GPS reserves the right to modify Products without any obligation to notify, 
supply or install any improvements or alterations to existing Products.



No Other Warranties
THE FOREGOING WARRANTY IS EXCLUSIVE OF ALL OTHER WARRANTIES, WHETHER WRITTEN, ORAL, 
IMPLIED OR ARISING BY STATUTE, COURSE OF DEALING OR TRADE USAGE, IN CONNECTION WITH THE 
DESIGN, SALE, INSTALLATION, SERVICE OR USE OF ANY PRODUCTS OR ANY COMPONENTS THEREOF, 
INCLUDING, BUT NOT LIMITED TO, ANY WARRANTY OF MERCHANT ABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 

Limitation of Liability
THE EXTENT OF HEMISPHERE GPS’ LIABILITY FOR DAMAGES OF ANY NATURE TO THE END PURCHASER OR 
ANY OTHER PERSON OR ENTITY WHETHER IN CONTRACT OR TORT AND WHETHER TO PERSONS OR 
PROPERTY SHALL IN NO CASE EXCEED, THE AGGREGATE, THE COST OF CORRECTING THE DEFECTIVE ITEM. 
IN NO EVENT WILL HEMISPHERE GPS BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF USE OR FOR ANY 
SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR CONTINGENT DAMAGES, EVEN IF HEMISPHERE GPS 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. WITHOUT LIMITING THE FOREGOING, 
HEMISPHERE GPS SHALL NOT BE LIABLE FOR ANY DAMAGES OF ANY KIND RESULTING FROM 
INSTALLATION, USE, QUALITY, PERFORMANCE OR ACCURACY OF ANY PRODUCTS.

Governing Legislation
To the greatest extent possible, this warranty shall be governed by the laws of the State of 
Arizona. In the event that any provision hereof is held to be invalid by a court of competent 
jurisdiction, such provision shall be severed from this warranty and the remaining provisions 
shall remain in full force and effect. 

Obtaining Warranty Service
In order to obtain warranty service, the end purchaser must bring the Product to a 
Hemisphere GPS approved service center along with the end purchaser's proof of purchase. 
For any questions regarding warranty service or to obtain information regarding the location 
of any of Hemisphere GPS' approved service centers, contact Hemisphere GPS at the 
following address:

Hemisphere GPS 
8444 N. 90th Street, Suite 130 
Scottsdale, AZ 85258 
Phone: 480-348-9919 Fax: 480-348-6370 
techsupport@hemispheregps.com 
www.hemispheregps.com

Documentation Feedback
Hemisphere GPS is committed to the quality and continuous improvement of our products 
and services. We urge you to provide Hemisphere GPS with any feedback regarding this 
guide by writing to the following email address: DocFeedback@hemispheregps.com
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1: Introducing the VS100
Overview

Precise applications demand the heading and positioning performance 
of the VS100 Series GPS Compass. The VS100 Series is designed to 
provide a highly-accurate GPS heading which takes into account the 
pitch, roll and speed of various vehicles and vessels. It features our 
Crescent-based receiver and two separate antennas to achieve heading 
accuracy ranging from 0.1 to 0.3 degrees (rms), depending on the 
antenna separation. Ideal for professional machine control and 
navigation, the VS100 Series also offers a differential positioning 
performance of less than 60 centimeters, 95 percent of the time. 

The VS100 Series includes two versions, the VS100 and the VS110. The 
VS100 kit comes with two A20 antennas, and supports GPS and SBAS 
signals. 

The VS110 kit comes with an A20 and an A30 antenna, and supports 
GPS, SBAS, and Beacon signals. 

Note: The phrase “VS100 Series” is used throughout this manual as a 
generic name for both the VS100 and the VS110 versions.
2



  VS100 Series User Guide
Figure 1-1. VS100 GPS Compass.

Powered by Hemisphere GPS’ Crescent Receiver Technology, the VS100 
Series GPS Compass boasts:

• higher update rates

• noise-reduced raw measurements

• more memory

• more processor capacity

• lower power consumption

• more advanced applications and sophisticated configurations

• tighter coupling of measurements from separate antennas

With more accurate code phase measurements, improved multipath 
mitigation and fewer components than competing products, the VS100 
Series offers superior accuracy and stability.
3



1: Introducing the VS100
 What’s Included

Please look over the parts shipped with your system. If any part appears 
to have been damaged during shipping, please contact your freight 
carrier. If any parts are missing, please contact your dealer.

Figure 1-2. VS100 Series system parts diagram.
4
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Parts List

Note: The VS100 kit comes with two A20 antennas. The VS110 kit 
comes with one A20 antenna, one A30 antenna, and one A20 height 
adaptor. The basic mounting instructions apply to all antenna 
installations.

Table 1-1:  VS100 Series Parts List

Diagram 
Letter

Part Name Qty
Part 
Number

Not 
pictured

Marketing CD 
(Includes user guide)

1 0132-0127

A Crescent receiver model  
(one of the following):

VS100 
VS110 

1  

803-3014 
803-3015

B Receiver mounting bracket  
(two brackets)

1 710-0056

C *A20 antenna 2 804-3032

D Antenna magnetic mount 
(with mounting plates)

2

E Antenna cable (TNC-TNC), 3 m 2 052-0004

F Data serial cable (DB9-DB9), 3 m 2 050-0011

G Power cable, 3 m 1 054-0009

H Adapter, 5/8" male to 1" female, 
PVC

2 600-1213
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2: Understanding the VS100
GPS Overview

The VS100 Series automatically tracks and calculates position 
information regardless of whether you are using GPS or differential 
GPS (DGPS) corrections.

When the VS100 Series is turned on for the first time, it attempts to 
acquires any available GPS satellites within view and to use the 
satellite-based augmentation system (SBAS) differential service.

If SBAS is not available in your area, you may be able to use Beacon 
corrections, depending on your model. Alternatively, you may use an 
external source of differential corrections.

GPS Operation

The following sections give a general overview of the VS100 Series’ 
internal GPS operations.

Automatic Tracking - The VS100 Series automatically searches for 
GPS satellites, acquires the signals and calculates the navigation 
information required for positioning and tracking. All this is done 
automatically without operator input.

Receiver Performance - The VS100 Series finds four or more GPS 
satellites in the visible sky and uses the information from those 
satellites to compute a position (within 2.5 meters). 

There is a margin of error within the GPS data calculations. To 
compensate for that margin of error, the VS100 Series also tracks a 
differential correction. Using the differential corrections, the margin of 
error in the position calculation is decreased to less than 1 meter.

There are two main issues that affect GPS receiver performance: 
antenna positioning and satellite acquisition quality.

When the VS100 Series’ antennas are properly positioned, with a clear 
view of the sky, the receiver uses the coded information transmitted 
8
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from the satellites to the GPS antennas in order to calculate a range to 
each satellite. 

GPS is essentially a timing system. Ranges are calculated by timing 
how long it takes for the GPS signal to reach the GPS antenna. To 
calculate the geographic location, the GPS receiver uses a complex 
algorithm which includes the satellite locations and ranges to each 
satellite. Receiving signals from 4 or more of satellites allows the GPS 
receiver to compute more accurate 3-dimensional coordinates.

Differential Operation

One of the benefits of Differential GPS (DGPS) is that it mitigates the 
effects of errors, including atmospheric errors, timing errors and 
satellite orbit errors, while at the same time enhancing system integrity.

When using only standard GPS signals (autonomous mode), the VS100 
Series automatically tracks and calculates a position within 2.5m 
accuracy. In order to improve positioning quality to sub-meter levels, 
the VS100 Series receiver utilizes differential corrections from one of the 
following sources:

• SBAS (WAAS, EGNOS, MSAS and others)

• Hemisphere GPS’ patented e-Dif® or L-Dif® applications (requires a 
subscription code)

• radio beacon corrections (model dependent)

For more information on available differential services and the 
associated commands, please refer to Hemisphere GPS’ GPS Technical 
Reference manual.

SBAS tracking - The VS100 Series will automatically scan and track 
SBAS signals. In North America the SBAS network of satellite is referred 
to as WAAS, in Europe it is EGNOS, and in Japan it is MSAS. The VS100 
Series features two-channel tracking. This enhances the VS100 Series 
ability to maintain a lock on an SBAS satellite when more than one 
satellite is in view. This redundant tracking approach provides more 
9



2: Understanding the VS100
consistent tracking of SBAS signals when in an area where satellite 
signal blockage is possible.

e-Dif - In extended differential (e-Dif), the receiver can perform with 
differential-like accuracy for extended periods without an external 
differential service. e-Dif models the effects of various errors for 
extended periods by computing its own set of pseudo-corrections. e-Dif 
may be used in any geographic area and is especially useful where 
SBAS networks have not yet been installed, such as South America, 
Africa, Australia and Asia.

The positioning performance of the receiver depends on how well e-Dif 
is able to model the environmental errors. The more accurately e-Dif is 
able to model the errors, the longer that e-Dif will provide reliable, 
accurate positioning. The accuracy of positioning will slowly drift over 
time, which limits use of e-Dif to approximately 30 to 40 minutes. 
However, if your application can tolerate a wider range of positioning 
accuracy and therefore certain amount of drift, e-Dif can be used for 
longer periods. Our testing has shown that accuracy will often be better 
than 1.0 m virtually 95% of the time after 30 minutes.

L-Dif/RTK - Local differential (L-Dif) (a technique exclusive to 
Hemisphere GPS) and Real Time Kinematic (RTK) technology are 
available on Crescent based GPS receivers. RTK and L-Dif require the 
use of two separate receivers. Both L-Dif and RTK make use of a 
stationary base station (primary receiver) unit that broadcasts 
corrections over a wireless link to the rover (secondary receiver) unit. 
The localized corrections are processed on the rover to achieve superior 
accuracy and repeatability. Performance testing has shown positioning 
accuracy at the centimeter level.

Beacon Operation - Many marine authorities, such as coast guards, 
have installed networks of radio beacons that broadcast DGPS 
corrections. There are nearly 200 beacon stations throughout the world. 
Increasingly, this radio beacon network is also being used for land 
based applications. The VS110 comes equipped with an integrated dual-
channel beacon receiver. The VS110 can automatically use the signal 
10
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from the closest beacon station, or you can manually tune it to a specific 
signal.

SBAS Satellite Signal Loss? No Problem.

The exclusive Hemisphere GPS COAST™ software enables VS100 
Series receivers to use old DGPS correction data for 40 minutes or more 
without significantly affecting the quality of positioning. 
11



2: Understanding the VS100
VS100 Series Overview

The VS100 Series provides accurate, reliable heading and position 
information at high update rates. It consists of a high performance GPS 
receiver and two multipath-resistant antennas for GPS signal 
processing.

The VS100 Series uses moving base station Real-Time Kinematic (RTK) 
technology to achieve very precise heading accuracies.

Moving Base Station RTK

RTK technology uses two antennas. One antenna is designated as the 
primary GPS, while the other is designated as the secondary GPS.

The two antennas are mounted at a leveled fixed distance from each 
other. The default distance is 0.5 meters. Imagine a sphere surrounding 
the primary antenna. In theory, the secondary antenna will only fall on 
the surface of the sphere surrounding the primary antenna. Since the 
location of the secondary antenna is constrained to a particular area, the 
VS100 Series is able to limit one variable when computing GPS satellite 
positioning data. 

Figure 2-1. Primary antenna’s search volume.

Primary 
antenna

0.5 m  
baseline
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Therefore, when the VS100 Series computes a position it is based on 
the center of the primary antenna. Using both L1 GPS C/A code and 
carrier phase data, the VS100 Series’ receiver can calculate the location 
of the secondary antenna. This is calculated to a very highly precise, 
sub-centimeter level. The positions of the primary and secondary 
antennas in relations to each other are used to determine heading.

Note: The VS100 Series RTK algorithm only uses GPS to calculate 
heading. Differential corrections are not used in this calculation and will 
not affect heading accuracy.

Supplemental Sensors

The VS100 Series contains an integrated tilt sensor and gyro. The tilt 
sensor and the gyro may be turned on or off individually; however, the 
functionality of the VS100 is fully optimized when both are used.

Both sensors act to reduce the RTK search range, which improves 
heading startup and re-acquisition times. This also improves heading 
reliability and accuracy by eliminating other possible errors.

Please refer to the GPS Technical Reference manual for specific 
commands to re-calibrate, query or change the status of these sensors.

Tilt aiding - The VS100 Series’ internal tilt sensor (accelerometer) 
comes factory calibrated and enabled. The tilt sensor is able to 
constrain the RTK search range because the VS100 knows the 
approximate inclination of the secondary antenna in relation to the 
primary antenna. 
13



2: Understanding the VS100
The tilt sensor is able to limit the search space to a horizontal ring on the 
surface of the sphere. By reducing the search area, startup and re 
acquisition times are decreased considerably. (See Figure 2-2 .)

Figure 2-2. VS100 Series’ tilt aiding.

Gyro aiding - The gyro automatically initializes and calibrates itself 
whenever power is turned on to the unit. If you would like to manually 
calibrate the gyro, commands are available in the GPS Technical 
Reference manual. When the gyro is first initializing, the gyro must 
calibrate itself under typical operating conditions. 

For example, if you will be using the VS100 Series on a high-speed, 
maneuverable craft, you must use the receiver under typical conditions 
for the first 5 to 10 minutes after turning on power, rather than sitting 
stationary.

The VS100 Series’ internal gyro offers two benefits. 

1. It decreases re acquisition times when satellite signals are 
obstructed and the GPS heading is lost. The gyro limits the search 
area required for RTK by providing a relative change in angle since 
the last computed heading. When used in conjunction with the tilt 

Tilt 
Angle
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sensor, the search area is reduced to a wedge-shaped range. (See 
Figure 2-3 .)

Figure 2-3. VS100 Series’ gyro aiding.

2. It can provide an accurate substitute heading for a short period 
(depending on the roll and pitch of the vessel), ideally seeing the 
system through to re-acquisition. The gyro will provide an alternate 
heading source accurate to within 1° for up to 3 minutes if either 
antenna loses a GPS signal.

If the signal is lost for more than 3 minutes, the VS100 Series will 
assume the gyro readings have drifted too far and will no longer 
provide a heading output.

Time Constants

The VS100 Series has custom time constants. Depending on the type of 
vessel you are using and how it performs, you may want to adjust the 
time constants. For instance, if you have a vessel that is very large and 
not able to turn or pitch quickly, you may want to increase the time 
constant to smooth the heading, course-over-ground, and speed 
measurements. 

However, you must be careful not to increase or decrease this value if it 
is not warranted by the performance of the vehicle. The could cause 
15



2: Understanding the VS100
incorrect measurements. If you are unsure if you need to adjust this 
value, it is best to leave it at the default value.

Heading - The $HEHDT and $GPHDT messages provide the true 
heading measurements. The heading time constant allows you to adjust 
the level of responsiveness of the measurement. The default value of 
this constant is 2.0 seconds of smoothing when the gyro is enabled. If 
you turn off the gyro, the equivalent default value of the heading time 
constant is 0.5 seconds of smoothing. However, if you turn off the gyro, 
you will need to enter this heading constant manually. Increasing the 
time constant will increase the level of heading smoothing.

Pitch - The $PSAT,HPR message provides the pitch measurement. The 
pitch time constant allows you to adjust the level of responsiveness of 
this measurement. The default value of this constant is 0.5 seconds of 
smoothing. Increasing the time constant will increase the level of pitch 
smoothing.

Heading rate -  The $HEROT message provides the heading change 
measurement. The heading rate time constant allows you to adjust the 
responsiveness level of this measurement. The default value of this 
constant is 2.0 seconds of smoothing. Increasing the time constant will 
increase the level of heading smoothing.

Course-over-ground (COG) -  The $GPVTG message provides the 
course-over-ground (COG) measurement. The COG time constant 
allows you to adjust the level of responsiveness of this measurement. 
The default value of this constant is 0.0 seconds of smoothing. 
Increasing the time constant will increase the level of COG smoothing. 
COG is computed using the primary GPS antenna only, and its accuracy 
is dependant upon the speed of the vessel (noise is proportional to 1/
speed). When stationary, this value is invalid.

Speed  - The $GPVTG message provides the speed measurement. The 
speed time constant allows you to adjust the level of responsiveness of 
this measurement. The default value of this parameter is 0.0 seconds of 
16



  VS100 Series User Guide
smoothing. Increasing the time constant will increase the level of speed 
measurement smoothing.
17
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3: Installing the Hardware
Mounting the Antennas

Selecting the Antenna Orientation

The VS100 Series GPS compass can be installed to provide heading and 
either pitch or roll.

The relation of the antennas to the boat’s axis determine whether the 
VS100 Series will output pitch or roll readings. 

Note: The primary antenna is used for positioning and the primary and 
secondary antennas, working in conjunction, can output heading and 
pitch/roll values.

Pitch - The most common installation is for heading and pitch. 
Orienting the antennas parallel to, and along the centerline of the axis 
of the boat will provide a true heading. 

If you are using a gyrocompass, you can enter a heading bias in the 
VS100 Series to calibrate the physical heading to the true heading of the 
vessel.

Roll  -  You can also install the antennas for heading and roll readings. 
Orienting the antennas perpendicular to the centerline of the boat’s axis 
will provide roll readings. 

Note: If you choose this installation, you will need to enter a heading 

bias in the VS100 Series. The heading bias will be +90° if the primary 

antenna is on the starboard side and -90° if the primary antenna is on 
the port side of the boat.

Planning the Optimal Antenna Placement

Proper antenna placement is important to obtain a high-precision GPS 
reading. Antennas must be placed:

• with a clear view of the horizon 
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• away from other electronics and antennas

• along the centerline of the vessel

Warning! The primary antenna must be installed along the 
centerline of the vessel. There is no way to adjust the position 
readings if the primary antenna is installed off the centerline. The 
positions are computed for the primary antenna.

• on a level plane

• at a maximum separation of 2.0 m (default is 0.5 m)

• away from radio frequencies 

• as high as possible 

For the best results, the antennas should be oriented so that the 
antennas’ connectors face the same direction

See Figure 3-1 through Figure 3-3 for examples.

Note: In the VS110 kit, the A30 antenna is used for positioning, and 
should be mounted as the primary antenna.
21



3: Installing the Hardware
Figure 3-1. Mounting the Antennas
22
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Figure 3-2. Heading and roll installation: top-down view of boat.

Figure 3-3. Antenna Installation: Cross-section of boat.
23



3: Installing the Hardware
Mounting the Antennas

The antennas may be mounted with a magnetic mount, pole mount or 
rail mount configuration. 

The antennas can be secured to a 5/8th treaded pole, or a 1-14-UNS-2B 
treaded mount using the mounting adapters.

Note: The VS110 kit contains one A30 antenna, one A20 antenna, and 
an A20 height adapter. The A30 antenna has a slightly higher profile 
than the A20, so the A20 height adapter is used to bring the two 
antennas level. If the adapter is not used, a non level bias calculation 
will have to be entered into the system. (See page 56.) 

Warning!The maximum allowable antenna separation is 2.0 
meters. Any greater distance may result in an incorrect heading.

Magnetic Mounting  - The magnetic mount can be screwed into the 
bottom of the antenna and mounts to any metal surface. 

If there are no metal surfaces, use the metal disc and foam adhesive 
included in your kit to mount the antenna. To use the metal disc and 
foam adhesive:

1. Select a location and orientation that meets the requirements 
outlined in “Selecting the Antenna Orientation” on page 20 and 
“Planning the Optimal Antenna Placement” on page 20. 

2. Thread the magnetic mount into the mounting bracket on the 
bottom of the antenna. Hand tighten only.   

Warning!When threading the magnetic mounts, hand tighten 
only. Damage resulting from over-tightening is not covered by 
the warranty.
24
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3.

4. Clean and dry the mounting surface on the vessel.

5. Remove the backing from one side of the foam adhesive and press 
the metal plate onto the mounting surface on the vessel.

6. Remove the backing from the other side of the foam adhesive.

7. Press the metal plate onto the mounting surface on the vessel.

8. Apply firm pressure to ensure good adhesion.

9. Place the antenna on top of the metal disc.

10. Ensure that the antenna is secure in its mounting position.

Pole Mounting - Alternately, you may pole-mount the antennas using 
existing hardware on your vessel. 

To mount the antenna on a pole mount bracket:

1. Select a location and orientation that meets the requirements listed 
in “Selecting the Antenna Orientation” on page 20 and “Planning 
the Optimal Antenna Placement” on page 20. 

2. Thread the pole mount into the mounting bracket on the bottom of 

the antenna. Hand tighten only. 
25



3: Installing the Hardware
Warning!When threading the pole mounts, hand tighten only. 
Damage resulting from over-tightening is not covered by the 
warranty.

Note: The pole shown in the photos is not included.

3. Mark and drill any mounting holes necessary for the pole mounts.

Rail Mounting - Alternately, you may rail mount the antennas using 
existing hardware on your vessel. 

To rail mount the antennas:

1. Select a location and orientation that meets the requirements listed 
in “Selecting the Antenna Orientation” on page 20 and “Planning 
the Optimal Antenna Placement” on page 20. 

2. Use appropriate hardware to securely attach the antenna to the 
railing.

Note: The primary antenna is used for positioning and the primary and 
secondary antennas, working in conjunction, can output heading and 
pitch/roll values.
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Routing and Securing the Antenna Cable

To route and secure the antenna cables, please review the following 
guidelines.

The two enclosed antennas each require a 50 Ω impedance antenna 
extension cable such as RG-58U (up to a maximum of 15 m (49 ft.) in 
length) for proper operation. 

3. The GPS receiver inside the VS100 Series requires a minimum 
input gain of 10 dB (and maximum of 40 dB before saturation will 
occur). The antennas offer 28 dB of gain, so the loss budget to 
accommodate for cable losses is 18 dB. 

4. Regardless of the cable material and length that you choose, you 
must ensure that cable losses are less than 18 dB of attenuation. 
Due to variances in the antenna gain and practical attenuation of 
cable materials and connectors, we recommend reducing this 
budget to 15 dB. This budget of 15 dB is present to overcome the 
resulting attenuation of a RF cable. 

5. When deciding on an antenna location, consider the amount of 
cable required. Keep in mind that a longer cable of the same 
material will result in a higher loss than a shorter one. If the overall 
loss of the longer cable exceeds 15 dB, the cable material will need 
to be changed. This normally means a more expensive material 
that has a larger diameter and less flexibility. The standard cables 
that come with the VS100 Series are of the RG58 material family. 
Their attenuation is approximately 0.8 dB/m. Including connector 
losses, the nominal loss of these RF cables is approximately 10 dB, 
which is within the tolerable loss budget. If a 15 m or 20 m cable 
run is required, a RG8 variety is available. If lengths longer than 20 
m are required, more sophisticated materials will be required.

For more information on cable length or low-loss cable, please contact 
your Hemisphere GPS dealer or Hemisphere GPS Technical Support. 
The following is a short summary of other readily available cable 
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3: Installing the Hardware
materials that have 50 Ω impedance. Cable loss cited below does not 
include any connector losses.

Warning! When choosing a route for the antenna extension 
cable:

• Avoid running cables in areas of excessive heat.

• Keep cables away from corrosive chemicals.

• Do not run the cable through door or window jams.

• Keep cables away from rotating machinery.

• Do not bend excessively or crimp the cable.

• Avoid placing tension on the cable.

• Remove unwanted slack from the cable at the receiver end. 

• Secure along the cable route using plastic tie wraps.

Warning! The VS100 Series receiver provides 5 VDC across the 
antenna ports. Connection to incompatible devices may result in 
damage to equipment.

Warning! Improperly installed cables near machinery can be 
dangerous. 

Table 3-1:  Cable Loss

Material Loss at GPS L1 (1.575 GHz)

RG58 0.78 dB / m

RG8 0.36 dB / m

Times Microwave LMR400 0.15 dB / m
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Mounting the Receiver

When mounting the VS100 Series receiver, please keep the following 
guidelines in mind.

• The receiver must be installed inside and away from the elements, 
and in a location that minimizes vibration, shock, extreme 
temperatures and moisture.

• It should be positioned horizontally, and with the face of the 
receiver facing the primary antenna. 

• The front panel (menu screen, LEDs and buttons) must be visible 
and accessible. 

• The back panel should be easily accessible in order to switch out 
cables and turn power on and off.

Mounting the VS100 Series

Use the enclosed kit to mount the receiver. To install the mounting 
brackets:

1. Slide the nuts through the opening along both sides of the receiver.
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3: Installing the Hardware
2. Place the bracket alongside the receiver and insert the screws so 
that they screw into the nuts.
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3. Screw down the brackets in your desired location.
31



3: Installing the Hardware
Connecting the Cables

This section contains instructions for connecting the cables for the 
power and serial ports.

Please review the following warnings before connecting the cables.

Warning! Do not run cables in areas of excessive heat. And:

• Keep cables away from corrosive chemicals.

• Do not run the extension cable through door or window jams.

• Keep cables away from rotating machinery.

• Do not bend excessively or crimp cables.

• Avoid placing tension on cables.

• Remove unwanted slack from the extension cable at the 
receiver end.

• Secure along the cable route using plastic wraps.

Connecting the Power Source

The power source for the VS100 Series must be between 9 - 36 Volts. 
Attach the power cable (Part no. 054-0009) to the connector labeled 
“Ground” to your power source.

Selecting a Port for GPS Data Message Output

The serial ports of the VS100 Series communicates at the RS-232C 
interface level with external data loggers, navigation systems and other 
devices. 
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There are two serial ports on the back panel of the receiver. These port 
use a standard DB9 socket connection.

Figure 3-4. Port connections on the VS100 Series.

The available ports and associated default baud rates, NMEA message 
types and update rates are shown in Table 3-2 .

Table 3-2:  Default Data Messages by Port

Port Baud Rate NMEA Messages
Update 
Rate

A, B 19,200 GGA, GSV 1 Hz
33



3: Installing the Hardware
Ports A and B have the connections detailed below on the DB9 socket.

If the NMEA data messages you desire are different from the default 
messages shown in Table 3-3, you will need to select those also.

Select the your NMEA message types and update rates by port using 
the Configuration Wizard (see “Getting Started” on page 37).

Table 3-3:  Pin Connections for Ports A and B

Pin Signal Description

2 TXD NMEA 0183, binary, and RTCM input 

3 RXD NMEA 0183, binary, and RTCM output

5 Signal Ground Signal return

6 Mark Input Event marker input

9 1 PPS Timing output
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Powering Up the System

Turn the VS100 Series “ON” or “OFF” using the ON/OFF Power toggle 
switch on the rear panel. 

Figure 3-5. Turn the VS100 on at the 
Power toggle switch.
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4: Getting Started
Overview

When you are configuring the VS100 Series, a Configuration Wizard on 
the receiver interface walks you through the setup options. 

The Configuration Wizard allows you to save up to five different config-
uration settings. These different configurations are useful when using 
this product on different vessels or for different applications.

If you are using a personal computer, you may also use Hemisphere 
GPS’ PocketMax software to help configure the system. PocketMax is 
included on your CD.

PocketMax enables you to:

• tune your beacon, WAAS and OmniSTAR receivers and monitor 
reception, 

• configure GPS message output and port settings, 

• configure and monitor Vector related settings, and

• record various types of data.

PocketMax runs on PDA, and PocketMax PC runs on any PC or laptop 
computer. The most current version of the PocketMax software and the 
appropriate operating system requirements can be found on the Hemi-
sphere GPS website, or you can contact Hemisphere GPS. For help 
using PocketMax, please refer to the PocketMax User Guide
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Configuring the System

The Configuration Wizard option appears in the display on the front 
panel of the VS100 Series. See Table 5-1 on page 48 for an overview of 
the VS100 Series’ display screen and selection buttons.

This section covers the basic items you need to set in the Configuration 
Wizard to get up and running. 

Figure 4-1 shows the Configuration Wizard.

Note: The basic setup instructions outlined in this section assumes 
that:

• the antennas are installed parallel to, and along the centerline of, the 
boat’s axis, and

• the antennas are separated by 0.5 meters.

If this is not the case, you will need to enter the actual antenna separa-
tion and bias in the Wizard.
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Figure 4-1. Configuration Wizard.

Using the Configuration Wizard

1. Select the “Config Wizard” option from the main menu. 

2. In the “Config Wizard” submenu, select “Proceed Wizard.”

3. Select “Create New” to create a new configuration. You are 
prompted to enter a name for your configuration. 
 
If you have modified the current receiver setup, you can also save 
the configuration in this submenu.

GPS >
Autonomous >
Config Wizard >
System Setup >

Proceed Wizard >
Delete Saved >
Use Previous >
Cancel >

Create New >
Save Current >
Back >
Top Menu >

Enter Name >  A
DIFF > SBAS
Data Port A >
Data Port B >
Elev Mask > 5
MaxDGPSage > 3600
Port A > 9600
Port B > 9600
Aiding Features >
Time Constants >
Bias, Neg. Tilt >
Ant. Sep > 0.500
Pitch/Roll > Pitch
Save to Location >
Back >
Top Menu >

GGA > 1 Hz
GLL > Off
GSA > Off
GST > Off
GSV > Off
HDT > Off
HPR > Off
RMC > Off
RRE > Off
VTG > Off
ZDA > Off
BIN95 > Off
BIN96 > Off
Back > 

Gyro-aid > Yes
Tiltaid > Yes
Calibrate Tilt > 
Back >

HTAU > 0.5s
HRTAU > 0.0s
COGTAU > 0.0s
SPDTAU >0.5s
PTAU > 0.0s
Back >

Heading > 0.0
Pitch/Roll > 0.0
Neg Tilt > No
Level Op. > Yes
Back >

Save to Location >
Not Used1 >
Not Used2 >
Not Used3 >
Not Used4 >
Not Used5 >
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4. Use the arrow buttons to select a letter and then press the enter 
button to save the letter. The cursor will move to the right. Enter a 
blank character at the end of your name until the “>” character 
appears at the end of the name. Press the enter button again.

5. In the same menu, select “DIFF” to set a DGPS Source. SBAS is the 
default. The options are SBAS, Beacon, Autonomous, External 
RTCM, e-Dif, and L-Dif.

Note: Beacon is only available with the VS110. e-Dif and L-Dif require a 
subscription.

6. To change the type of GPS data message that is sent to the data 
ports, select either “Data Port A” or “Data Port B” from the menu 
list.

7. You can configure the elevation cutoff angle, by selecting “Elev 
Mask”. You may set the elevation cutoff angle between 0° and 45°. 
The default value is 5°.

8. You also have the option to set the maximum DGPS age. The 
maximum DGPS age is 2700 seconds (45 minutes) by default.

9. If the default baud rate on the selected port does not match that of 
the external device you are connecting to, you will need to 
configure the Baud Rate, using the “Port A” or “Port B” entries.  
 
4,800; 9,600; 19,200; 38,400; 57,600; and 115,200 are the available 
baud rates. 

Note: PocketMax does not support a 115,200 baud rate.

10. The “Aiding Features” menu enables you to turn the Gyro-aid and 
Tiltaid features on or off. For more information on disabling the 
aiding features, please see “Disabling the Tilt Aid” on page 43 or 
“Disabling the Gyro-aid” on page 44.

11. While the default “Time Constants” settings will work for most 
users, if you have a large, slow turning vessel, or a small, quick 
moving vessel you may want to adjust the time constants to reduce 
heading start up and re acquisition times. 
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For details on configuring the time constants, see “Adjusting the 
Time Constants” on page 45.

12. If you did not install the antenna’s parallel to and along the boat’s 
centerline, you will need to enter a heading bias in the “Heading” 

field of the “Bias, Neg. Tilt” menu. The heading bias (-180° – 
+180°) compensates for any offset from the centerline.

Note: If you installed the antennas for roll (perpendicular to the boat’s 

axis), rather than pitch, you must enter the heading bias (+/- 90°). You 
must also enter the bias for roll (see below).

13. Enter the bias for pitch or roll (-15° - +15°) to compensate for any 
offset from the boat’s centerline. Enter this bias in the “Pitch/Roll” 
field of the “Bias, Neg. Tilt” sub-menu.

14. If you did not install the antennas 0.5 meters apart, enter the actual 
antenna separation In the “Ant. Sep” field. The available range is 0 - 
2.0 meters

15. Most users install the antennas for pitch. However if you install the 
antennas for roll, you will need to configure the Crescent VS100 for 
roll. In the “Create New” menu set the “Pitch/Roll” setting to “Roll”.

16. To save your new configuration, select the “Save to Location” field. 
You will be prompted for a location to save your configuration. 
 
Select one of the empty slots, noted by the name “Not Used”, or 
select a slot with an existing configuration to overwrite it.  
 
After your configuration is saved, you must select it from the 
Configuration Wizard in order to activate it.(This way, you may 
continue to enter different receiver configurations without 
upsetting the current operation of the receiver.)Re-enter the 
Configuration Wizard and select the configuration to use.
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Disabling the Aiding Features

While the default settings will work for most users, you can configure 
the aiding features to further reduce heading start up and re-acquisition 
times.

Disabling the Tilt Aid 

The VS100 Series’ tiltaid (accelerometer) is enabled by default and con-
strains the RTK heading solution to reduce startup and re acquisition 
times.

The tiltaid is pre-calibrated at the factory. However, if you experience 
any tilt measurement offset, you can re calibrate the tilt sensor by using 
the “Calibrate Tilt” option in the Vector menu. See “Vector menu.” on 
page 58 for a menu map on how to access this feature. Be sure that the 
receiver is perfectly level before recalibrating the tiltaid.

The only times you might need to disable the tiltaid feature are:

• if you were unable to install the VS100 Series on a level plane with 
the antennas. The tilt sensor is located inside of the VS100 Series, 
so it is important that the VS100 Series be installed on a level 
horizontal plane.

Warning! If you were unable to install the VS100 Series in a 
horizontal plane with the antennas, you MUST DISABLE tiltaid.

• if troubleshooting, to ensure the receiver is working properly.

You can turn the tiltaiding feature off either through the Configuration 
Wizard or through the Vector menu.
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Disabling the Gyro-aid 

The VS100 Series’ internal gyro-aid is enabled by default. The gyro:

• shortens re-acquisition times when satellites are obstructed and 
heading is lost, by reducing the search volume required for the RTK 
solution, and

• provides accurate substitute headings for a short period 
(depending on the roll and pitch of the vessel) ideally seeing you 
through to re-acquisition.

The only time you might need to disable the gyro-aid is during trouble-
shooting, to ensure the receiver is working properly.

Warning!Do not exceed turn rates of 90 degrees-per-second! 
The VS100 Series uses gyro measurements to obtain a heading 
rate measurement, and the gyro cannot measure beyond this 
rate. 

You can turn the gyro-aiding feature off either through the Configura-
tion Wizard or through the Vector menu.
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Adjusting the Time Constants

The VS100 Series default settings are fine for most users. If desired, you 
can set the following time constants to further smooth heading, course-
over-ground and speed measurements.

Table 4-1 below provides an overview of the time constant values that 
you can set in the Configuration Wizard, including the formulas for find-
ing the optimal value of each time constant for your particular vessel.

For further details, please consult Hemisphere GPS’ GPS Technical Ref-
erence.

Table 4-1:  Time Constants  

Time 
Constant

Purpose Range Formula

HTAU 
(Heading)

Adjusts the responsive-
ness to true heading. 
 
If vessel is large and 
unable to turn quickly, 
you may want to 
increase this value.

2.0 s with gyro 
enabled 
(default) 

0.0 to 60 s

htau (s) = 40/max rate of turn 

(°/s) (with gyro ON)

htau (s) = 20/max rate of turn 

(°/s) (with gyro OFF)

HRTAU 
(Heading 
Rate)

Adjusts the responsive-
ness to the rate of head-
ing change.

If vessel is large and 
unable to turn quickly, 
you may want to 
increase this value.

2.0 s with gyro 
enabled 
(default) 

0.0 to 60 s

hrtau (s) = max rate of turn (°/

s2)/10
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COGTAU 
(Course-
Over-
Ground)

Adjusts the responsive-
ness to the course-over-
ground measurement.

If vessel is small and 
dynamic, leave this value 
at 0.0 s to be conserva-
tive. If the vessel is large 
and resistant to motion, 
you may want to 
increase this value.

0.0 s (default)

0.0 to 60 s

cogtau (s) = max rate of 

change of course (°/sec)/10

SPDTAU 
(Speed)

Adjusts the responsive-
ness to speed.

If vessel is small and 
dynamic, leave this value 
at 0.0 s to be conserva-
tive. If the vessel is large 
and resistant to motion, 
you may want to 
increase this value. 

0.0 s (default)

0.0 to 60 s

spdtau (s) = max acceleration 

(m/s2)/10

PTAU 
(Pitch)

Adjusts the responsive-
ness to pitch.

If vessel is large and 
unable to pitch quickly, 
may want to increase this 
value.

0.5 s (default)

0.0 to 60 s

ptau (s) = 10/max rate of pitch 

(°/s)

Table 4-1:  Time Constants (continued)

Time 
Constant

Purpose Range Formula
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5: Operating Basics
Overview

Operating the VS100 Series is simple. Turn it on and you are ready to 
go.

Most users connect the VS100 Series to their existing navigation system 
during installation. These users will receive the VS100 Series’ position 
and heading updates through the interface of their existing system.

The interface on the front panel of the VS100 Series is helpful for 
configuring or changing system settings. In addition, the LEDs on the 
panel will notify you in the event of a GPS or DGPS signal loss.

Figure 5-1. LED Indicators, Display Screen and Selection Buttons
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Viewing GPS/DGPS Status

Most users will receive position and heading information through their 
on-board navigation system. If you have not connected the VS100 
Series to an existing navigation system, or are troubleshooting your 
unit, you may need to view GPS, DGPS or Beacon status on the VS100 
Series’ display screen.

Do I Have a Signal?

Figure 5-1 shows which LEDs on the VS100 Series will indicate GPS, 
DGPS or Beacon signal lock when illuminated.

If you do lose the differential signal lock, the Hemisphere GPS COAST 
technology allows the VS100 Series to perform well for up to 45 minutes 
with old correction data. The amount of time you can “coast” depends 
on the degree of tolerable drift. 

Note: In order to obtain a full set of SBAS corrections, the VS100 Series 
must receive the ionospheric map over a period of a few minutes. After 
this, the receiver can “coast” until the next set of corrections has been 
received.

How Good is the Quality of My Signal?

In addition to the LED indicators for signal lock, the VS100 Series’ 
display screen indicates the quality of your signal.

The bar chart shows an indication of the quality of the GPS and DGPS 
(or if applicable, Beacon) signal. The first group of bars shows the GPS 
signal; the second group of bars shows the DGPS or Beacon signal.
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Each bar represents a distinct channel and its associated signal quality. 
The higher the bar, the better the signal. 

Note: If using autonomous or external correction mode, the DGPS 
signal indicator will not appear in the display. 

DGPS (SBAS)  -  The differential correction (or SBAS) signal indicator 
reflects the quality of each satellite signal, or the Bit Error Rate (BER). 

A full bar height reflects a signal lock and a BER of 0. A bar height only 2 
pixels tall reflects a signal loss, or a BER of 500 or greater. Bar heights in 
between reflect intermediate degrees of signal quality.

For example, when using WAAS, there are two satellites available, so 
two BERs are provided. 

Beacon - The Beacon indicator reflects the quality of the Beacon signal, 
or the signal strength (SS) and the signal-to-noise ratio (SNR).

A full bar height reflects a signal lock and an SS of 35 or greater, and an 
SNR of 24 or greater. A bar height only 2 pixels tall reflects a signal loss, 
or SS and SNR values of 0. Bar heights in between reflect intermediate 
degrees of signal quality.

If using Beacon, the first bar indicates SS signal quality; the second bar 
indicates SNR signal quality.
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Appendices
A: Troubleshooting

Troubleshooting a Signal Loss

With the Hemisphere GPS COAST and e-Dif technologies, you should be 
able to continue working in the event of a GPS or DGPS signal loss. 

General Troubleshooting Checklist (GPS, DGPS, and Beacon) - 

1. Check antenna connections.

2. Verify that antennas have an unobstructed view of the sky. 

3. Verify the lock status of the satellites.

4. Confirm baud rates match external sources.

5. Verify the differential source.

Beacon - When using Beacon signals, also check the following:

1. Verify that the receiver is tuned to the correct frequency and bit 
rate.

2. Verify antennas are away from potential sources of interference.

3. Ensure Beacon signal coverage is available in your area.

External RTCM - When using an external RTCM, also check the 
following:

1. Verify the pin-out between the RTCM source and the RTCM input 
port (The “ground” pin and pin-out must be connected, and from 
the “transmit” from the source must connect to the “receive” of the 
RTCM input port).

2. Verify that the baud rate of the RTCM input port matches the baud 
rate of the external source.

3. Ensure corrections are being transmitted to the correct port.

Troubleshooting Heading

In the event that you don’t receive any heading or incorrect heading 
values, use the following checklist:
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1. Verify that the primary antenna faces the stern, and the secondary 
antenna faces the bow (The primary antenna determines heading). 

2. Check the measurement of the antenna separation. The Measured 
Separation (MSEP) and Calculated Separation (CSEP) values are in 
meters, and should agree (+/- 1 centimeter.) CSEP will continuously 
change, so you should average this reading over a few minutes to 
obtain an approximate value.

Note: The standard antenna mounting configuration provides a 0.5° 
heading accuracy at 95% confidence. If you require more performance, 
you will need to increase the antenna separation (maximum 
recommended separation is 2.0 meters).

3. Reduce antenna separation – the separation between the antennas 
must remain below 2 meters for accurate and timely heading 
reading output.

4. Verify that the gyro-aid is enabled this will give heading for up to 3 
minutes in times of GPS signal loss.

5. Verify that tiltaid is enabled to reduce heading search times.

6. Monitor the number of satellites and the signal-to-noise ratio (SNR) 
values for both antennas. At least 3 of the satellites should have 
SNR values above 20.

7. Verify antenna connectors are facing in the same direction.
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B: FAQs

This section covers power, communication and external RTCM 
questions. For GPS and Heading troubleshooting, please see 
“Operating Basics” on page 47.

Q: Can the COAST technology work with corrections from an 
external source?

A: Yes, the VS100 Series will operate in a similar fashion with the COAST 
technology as when using SBAS or Beacon corrections. However, SBAS 
corrections have the advantage that they are separated into separate error 
components, allowing the VS100 Series to anticipate how errors will change 
over the coasting period with more consistent accuracy and for a longer 
period than regular RTCM range corrections. 

Q: My VS100 Series doesn’t appear to be communicating, what 
do I do?

A: This could be one of a few issues. You should check the following items.

1. Examine the power cable and its connector for signs of damage.

2. Ensure that you are properly powering the system with the correct 
voltage (9 to 36 Volts) by measuring the voltage at the receiver end of 
the power cable when the cable is connected to the power source. 

3. Check current restrictions imposed by power source (minimum 
available should be > 1.0 A).

4. Verify that the LCD has turned on, that time is incrementing in the upper 
right-hand corner of the display and configure the COM port baud rates 
appropriately through the menu system.

5. Verify polarity of power leads.

6. Check 1.0 A in-line power cable fuse.

7. Since you are required to terminate the power input with your choice of 
connector, ensure that you have made a good connection to the power 
supply.

8. Consult the troubleshooting section of the other device’s reference 
manual to determine if there may be a problem with that equipment.
54



  VS100 Series User Guide
Q: Am I able to configure the two serial ports with different 
baud rates?

A: Yes, the ports are independent. For instance, you may have one port set to 
4,800 and the other to 19,200 or vice versa.

Q: Am I able to have the VS100 Series output different NMEA 
messages through the two ports?

A: Yes, you may have different NMEA messages turned on for the two serial 
ports. Further, these NMEA messages may also be at different update rates.

Q: How can I determine what the current configuration of the 
VS100 Series is?

A: You can view the current configuration from various screens of the menu 
which show all configurable items of the receiver. Alternately, you may 
return the receiver to a previously saved configuration by selecting “Config 
Wizard> Use Previous” to return to a known configuration.

Q: My VS100 Series doesn’t appear to be using corrections 
from an external correction source, what could be the problem?

A: This could be due to a number of issues. You should check the following 
items.

1. Make sure that the corrections are of an RTCM SC-104 protocol.

2. Check to see that the baud rates of the port used by the VS100 Series 
matches that of the external correction source.

3. The external correction source should be using an 8 data bit, no parity, 
1 stop bit serial port configuration.

4. Inspect the cable connection to ensure there’s no sign of damage.

5. Check the pin-out information for the cables to ensure that the transmit 
line of the external correction source is connected to the receive line of 
the VS100 Series’ serial port and that the signal grounds are connected.

Save the configuration as the profile named “RTCM” in the 
Configuration Wizard, cycle the power and load the RTCM profile.

Q: Why am I not getting data from the VS100 SerieS?

A: There are several possible reasons for this. Please check the following 
items.

1. Check receiver power status LED to ensure that the receiver is powered.
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2. Verify that VS100 Series is locked to a valid DGPS signal (this can often 
be done on the receiving device or with PocketMAX).

3. Verify that VS100 Series is locked to GPS satellites (this can often be 
done on the receiving device or with PocketMAX).

4. Check integrity and connectivity of power and data cable connections.

Q: Why am I getting random data from VS100 Series?

A: There are three possible reasons for this. Please check the following 
items.

1. Verify that the RTCM or the Bin95 and Bin96 messages are not being 
output accidentally (send a $JSHOW command)

2. Verify baud rate settings of VS100 Series and remote device match 
correctly

3. Potentially, the volume of data requested to be output by the VS100 
Series could be higher than the current baud rate supports. Try 
increasing the baud rate to 38,400 for all devices or reduce the amount 
of data being output.

Q: I could not install my antennas so that they are the same 
height. How do I calibrate for the height offset?

A: You may enter an non-level bias calculation. This calculation adjusts the 
pitch/roll output in order to calibrate the measurement if the antenna array is 
not installed on a horizontal plane. The following NMEA message allows you 
to calibrate the pitch/roll reading.

$JATT,PBIAS,x<CR><LF>

Where x is a bias that will be added to the pitch/roll measurement, in 
degrees. The acceptable range for the pitch bias is -15.0 to 15.0 degrees. The 
default value is 0.0 degrees. 

To determine what the current pitch compensation angle is, send the 
following message.

$JATT,PBIAS<CR><LF>

Note: The pitch/roll bias is added after the negation of the pitch / roll 
measurement (if so invoked with the $JATT,NEGTILT command).
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C: Menu Map

There are five main menus available from the start-up screen of the 
VS100 Series:

• Vector

• GPS

• SBAS

• Configuration Wizard

• System Setup
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Vector

The Vector menu allows you to view and adjust Vector settings. Options 
vary depending on whether Pitch or Roll is selected, and include items 
such as aiding features, time constants, heading bias and antenna 
separation. 

Figure 6-1. Vector menu.

Vector >
GPS >
SBAS >
Config Wizard >
System Setup >

Display >
Aiding Features >
Time Constants >
Bias, Neg. Tilt >
Antenna Sep. >
Pitch/Roll > Pitch
Back >
Top Menu >

Heading: 180.00
COG: 10.00
Vel: 25.3 Km/h
ROT: 3.2
Pitch/Roll: 6.2
Back >
Top Menu >

Gyroaid > Yes
Tiltaid > Yes
Calibrate Tilt >
Back >
Top Menu >

HTAU > 0.5s
HRTAU > 0.0s
COGTAU > 0.0s
SPDTAU > 0.5s
PTAU > 0.0s
Back >
Top Menu >

Heading > 0.0
Pitch/Roll > 0.0
Neg Tilt > No
Level Op. > Yes
Back >
Top Menu >

Computed 0.53m
Measured > 0.53m
Back >
Top Menu >
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GPS

The GPS menu allows you to view and edit your GPS settings. Settings 
include the data port outputs, specific positioning parameters, UTC time 
offset, and satellite visibility and positioning information. 

Figure 6-2. GPS menu.

SBAS

The SBAS menu allows you to view your differential settings. The name 
of the differential menu shown in the display reflects your current 
differential source. So, for example, if you are using SBAS, you will see 
“SBAS” and the associated menu.

Vector >
GPS >
SBAS >
Config Wizard >
System Setup >

Position Status >
Satellites >
Configure >
Back >
Top Menu >

Lt 51°00.131035'
Ln 114°00.273158'
Hgt 1030.40m
Hdg 154.5°
Vel 10.5 km/h
Age 6.0 s
SV Count 10
HDOP 1.3
Precision >
NavCnd >ABBABB
DSP-ARM > 1F-1F
Back >
Top Menu >

CH01-SV23 EL 37
AZ 092 SRN 45
.
.
.
CH12-SV09 EL 45
AZ 183 SRN 47
Back >
Top Menu >

Elev Mask > 5°
MaxDGPSAge >2700
Data Port A >
Data Port B >
UTC Offset > -7h
Back >
Top Menu >

Res rms: 0.3m
s-a: 0.2m
s-b: 0.1m
Azimuth: 163.1°
s-Lat: 0.2m
s-Lon: 0.2m
s-Alt: 0.3m
Back >
Top Menu >

Car Smooth 11
Eph Exists 11
Eph Healthy 10
NotUsed Prev 11
Above Ele 11
Diff Corr 10
No Diff Corr 0
Back >
Top Menu >

DSP: CarLock Yes
DSP: BER Yes
DSP: DSPLock Yes
DSP: FrmSync Yes
DSP: TrkMode Yes
ARM: GSPLock Yes
ARM: DifData Yes
ARM: ARMLock Yes
ARM: DGPS Yes
ARM: Solutn Yes
Back >
Top Menu >
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Please find your differential source, below, for available menu options. 
Differential sources available vary by model and the purchased 
configuration. Potential options include:

• SBAS

• Beacon

• External RTCM

• Autonomous

From this menu, you can view your current status or adjust satellites 
tracked.

Figure 6-3. SBAS menu.

Vector >
GPS >
SBAS >
Config Wizard >
System Setup >

Signal Status >
Satellites >
Diff > SBAS
Back >
Top Menu >

BER 122: 0
BER 134: 0
LN 122: -54.0°
LN 134: 178.0°
Elev122: 9.8°
Elev134: 5.0°
Az 122: 114.0°
Az 134: 252.6°
Back >
Top Menu >

Mode > Auto
PRN1 122
PRN2 134
Back >
Top Menu >
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Figure 6-4. Beacon menu.

Figure 6-5. External RTCM menu.

Figure 6-6. Autonomous menu.

Configuration Wizard

The Configuration Wizard walks you through basic settings to get up 
and running. Please see Chapter 4, “Getting Started” to view the 
Configuration Wizard menu map.

Vector >
GPS >
Beacon >
Config Wizard >
System Setup >

Signal Status >
Configure >
Diff > Beacon
Back >
Top Menu >

F 295.0/200 AA
SS 34 SNR 26
MTP 100% WER 00
Unselected Bx
ID 1025 H 08
Back >
Top Menu >

Tune: Auto/Auto >
Auto Tune >
TuneBeaconName >
Back >
Top Menu >

Africa >
Asia >
Australia >
Central America >
Europe >
North America >
South America >
Back >
Top Menu >

Bermuda >
Canada >

USA >
Back >

Top Menu >

Alexandria VA
Annette IS AK

-
-
-

Youngstown NY
Back >

Top Menu >

Vector >
GPS >
External RTCM >
Config Wizard >
System Setup >

RTCM Port > Port A
RTCM Baud > 19200
Diff > Extern RTCM
Back >
Top Menu >

Vector >
GPS >
Autonomous >
Config Wizard >
System Setup >

No Diff Source
Diff > Autonomous
Back >
Top Menu >
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System Setup

The System Setup menu allows you quickly view and edit current 
system settings. General settings include such items as current 
applications, units, baud rates, logs, LED contrast, subscription code, 

display orientation (you can flip the display 180° by selecting “YES” 
under FLIP DISPLAY), and language.

Figure 6-7. System Setup menu.

GPS >
SBAS >
Config Wizard >
System Setup >

Display Apps >
Display Format >
Baud Rates >
Display Logs >
Software Display >
Contrast >
Animation > Off
Subscription >
Flip Display > No
Language >
Back >
Top Menu >

In Use > Vector
Other > Vector
Swap Applications >
Back >
Top Menu >

Display Update > 1Hz
Vel Unit > DM.M
Hgt Unit > meters
Vel Unit > km/h
Back >
Top Menu >

Port A > 9600
Port B > 9600
Back >
Top Menu >

GGA > No
GLL > 1Hz
GSA > 1Hz
GST >
GSV > 1Hz
…
RD1 > No
PCSI,1 > No
Back >
Top Menu >

Menu System >
Crescent App >
S/N >
SBX >
Back >
Top Menu >
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D: Specifications

VS100 Series Receiver Specifications

Notes:

*Depends on multipath environment, number of satellites in view, 
satellite geometry, baseline length (for local services), and ionospheric 
activity

**Depends on multipath environment, number of satellites in view, and 
satellite geometry

Table 6-1:  GPS Sensor Specifications

Receiver type L1, C/A code, with carrier phase smoothing

Channels Two 12-channel, parallel tracking 
(Two 10-channel when tracking SBAS)

Horizontal accuracy < 0.6 m 95% confidence (DGPS)*   

< 2.5 m 95% confidence (autonomous, no 
SA)**

Heading accuracy <0.30º rms @ 0.5 m antenna separation

<0.15º rms @ 1.0 m antenna separation

<0.10º rms @ 2.0 m antenna separation

Update rate (position 
and heading)

Up to 20 Hz 

Pitch/roll accuracy < 1º rms @ 0.5 m antenna separation

Rate of turn 90º / s max

Start up time < 60 s typical 

Heading fix < 20 s

Satellite reacquisition < 1 s
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Table 6-2:  Beacon Sensor Specifications (VS110)

Channels 2-channel, parallel tracking

Frequency range 283.5 to 325 kHz

Operating modes Automatic (signal strength or 
range), manual and database

Compliance IEC 61108-4 beacon standard

Table 6-3:  Communication Specifications 

Serial ports 2 full duplex 

Interface level  RS-232C

Baud rates 4,800 - 115,200

Correction I/O protocol RTCM SC-104, L-Dif (Hemisphere GPS 
proprietary)

Data I/O protocol NMEA 0183, Crescent binary, L-Dif 
(Hemisphere GPS proprietary)

Timing output 1 PPS (HCMOS, active high, rising edge sync, 
10 k, 10 pF load)

1 PPS accuracy 50 ns

Table 6-4:  Environmental Specifications

Operating Temperature -30°C to +70°C

Storage Temperature -40°C to +85°C

Humidity 95%, non-condensing

Table 6-5:  Power Specifications

Power Input Voltage 9 to 36 VDC
64



  VS100 Series User Guide
A20 Antenna Specifications       

Power Consumption < 5 W

Current Consumption < 360 mA @ 12 VDC

Antenna Voltage Output 5 VDC

Antenna Short Circuit 
Protection

Yes

Table 6-6:  Mechanical Specifications

Dimensions 189 mm L x 114 mm W x 71 mm H (7.4” L x 
4.5” W x 2.8” H)

Weight 0.86 kg (1.9 lb.)

Status indication Power, primary GPS lock, secondary GPS lock, 
differential lock, and heading lock

Power switch Miniature push-button

Power connector 2-pin, micro-Conxall

Data connectors DB9-female

Antenna connectors TNC-female

Table 6-5:  Power Specifications

Table 6-7:  GPS Sensor Specifications

GPS Frequency Range 1.575 GHz (L1)

GPS Bandwidth 20 MHz

GPS LNA Gain 34 dB

GPS LNA Noise 1.4 dB typical
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A30 Antenna Specifications       

Table 6-8:  Power Specifications

Input Voltage 5-12 VDC

Input Current 20-30 mA

Table 6-9:  Mechanical Specifications 

Enclosure
Polycarbonate 
Dimensions

130 mm dia. X 55 mm high 
(5.1” dia. X 2.2” high)

Weight 363 g (0.8 lb.)

Mounting Thread 5/8” female

Connector TNC female

Storage Temperature -40° C to +85°C

Operating Temperature -40° C to +85°C

Humidity 100% condensing

Table 6-10:  GPS Sensor Specifications

GPS Frequency Range 1.575 GHz (L1)

GPS Bandwidth 20 MHz

GPS LNA Gain 34 dB

GPS LNA Noise 1.4 dB typical

Table 6-11:  Power Specifications

Input Voltage 5-12 VDC

Input Current 50-60 mA
66



  VS100 Series User Guide
Table 6-12:  Mechanical Specifications  

EnclosurePolycarbonate 
Dimensions

130 mm dia. X 69 mm high (5.1” dia. X 
2.7” high)

Weight 590 g (1.31 lb.)

Mounting Thread 5/8”

Connector TNC female

Storage Temperature -40° C to +85°C

Operating Temperature -32° C to +74°C

Humidity 100% condensing
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A
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mounting 24
mounting examples 21
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mounting, pole mount 25
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primary, search volume 12
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B
base station, moving, RTK 12
baud rate 41, 55
Beacon 9

availability 41
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troubleshooting signal loss 52
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C
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connecting 29, 32
power 32
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wizard, using 40

D
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status 49

disabling
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E
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correction source 9
description of 10

EGNOS 9
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error, margin of, compensating for 8
external RTCM, when using 52

G
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menu map 59
operation 8
range calculations 9
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status 49

GPS Technical Reference manual 9
gyro 13, 44
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benefits 14
calibration, self or manual 14
disabling 44
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H
heading 20, 49

bias 20
troubleshooting 52

L
L-Dif 9
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M
mechanical
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menu map 57
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system setup 62
vector 58

mounting See antenna mounting
MSAS 9

N
NMEA messages 32, 55

P
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runs on 38
use of 38

position 49
power

A20 specifications 66
A30 specifications 66
connecting the source 32
powering up the system 35
specifications 65

R
radiobeacon, correction source 9
receiver, mounting 29
roll 42
RTK 12

and L-Dif 10
constrained heading solution 43
constraining search range 13
moving base station 12
use by VS100 12
use of antennas 12
VS100 algorithm 13

S
SBAS

and COAST 11
coasting between corrections 49
menu map 59
not available 8

receiving corrections 49
signal loss 11
tracking 9
use of 8

sensors
gyro 13
tilt 13
tilt, constraining the RTK search 
range 13

serial ports
availability and baud rates. 33
communicate at 32
communicate with 32

setup, system, menu map 62
signal

indicators 49
lock 49
lock, LED readout 49
loss, troubleshooting 52
quality 49

specifications
A20 antenna 65
A20 mechanical 66
A20 power 66
A30 antenna 66
A30 mechanical 67
A30 power 66
Beacon sensor 64
communication 64
environmental 64
GPS 63
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time constants 41, 45

adjusting 15, 45
course-over-ground 16
formulas for smoothing 15
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heading rate 16
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tracking, automatic 8
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U
updates, receiving 48

V
vector, menu map 58

W
wizard

configuration 38, 39, 61
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End User License Agreement
HEMISPHERE GPS
END USER LICENSE AGREEMENT

IMPORTANT - This is an agreement (the "Agreement") between you, the end purchaser 
("Licensee") and Hemisphere GPS Inc. ("Hemisphere") which permits Licensee to use 
the Hemisphere software (the "Software") that accompanies this Agreement. This 
Software may be licensed on a standalone basis or may be embedded in a Product. Please 
read and ensure that you understand this Agreement before installing or using the 
Software Update or using a Product.

In this agreement any product that has Software embedded in it at the time of sale to the 
Licensee shall be referred to as a "Product". As well, in this Agreement, the use of a 
Product shall be deemed to be use of the Software which is embedded in the Product.

BY INSTALLING OR USING THE SOFTWARE UPDATE OR THE PRODUCT, LICENSEE 
THEREBY AGREES TO BE LEGALLY BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU 
DO NOT AGREE TO THESE TERMS, (I) DO NOT INSTALL OR USE THE SOFTWARE, AND 
(II) IF YOU ARE INSTALLING AN UPDATE TO THE SOFTWARE, DO NOT INSTALL THE 
UPDATE AND PROMPTLY DESTROY IT. 

HEMISPHERE PROVIDES LIMITED WARRANTIES IN RELATION TO THE SOFTWARE. AS 
WELL, THOSE WHO USE THE EMBEDDED SOFTWARE DO SO AT THEIR OWN RISK. YOU 
SHOULD UNDERSTAND THE IMPORTANCE OF THESE AND OTHER LIMITATIONS SET 
OUT IN THIS AGREEMENT BEFORE INSTALLING OR USING THE SOFTWARE OR THE 
PRODUCT. 

 1. LICENSE. Hemisphere hereby grants to Licensee a non-transferable and non-
exclusive license to use the Software as embedded in a Product and all Updates 
(collectively the "Software"), solely in binary executable form. 

 2. RESTRICTIONS ON USE. Licensee agrees that Licensee and its employees will not 
directly or indirectly, in any manner whatsoever:

a. install or use more copies of the Software than the number of copies that have 
been licensed;

b. use or install the Software in connection with any product other than the Product 
the Software was intended to be used or installed on as set out in the 
documentation that accompanies the Software.

c. copy any of the Software or any written materials for any purpose except as part 
of Licensee's normal backup processes;

d. modify or create derivative works based on the Software;
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e. sub-license, rent, lease, loan or distribute the Software;

f. permit any third party to use the Software;

g. use or operate Product for the benefit of any third party in any type of service 
outsourcing, application service, provider service or service bureau capacity; 

h. reverse engineer, decompile or disassemble the Software or otherwise reduce it 
to a human perceivable form; 

i. Assign this Agreement or sell or otherwise transfer the Software to any other 
party except as part of the sale or transfer of the whole Product.

 3. UPDATES. At Hemisphere's discretion Hemisphere may make Updates available to 
Licensee. An update ("Update") means any update to the Software that is made 
available to Licensee including error corrections, enhancements and other 
modifications. Licensee may access, download and install Updates during the 
Warranty Period only. All Updates that Licensee downloads, installs or uses shall be 
deemed to be Software and subject to this Agreement. Hemisphere reserves the right 
to modify the Product without any obligation to notify, supply or install any 
improvements or alterations to existing Software. 

 4. SUPPORT. Hemisphere may make available directly or through its authorized 
dealers telephone and email support for the Software. Contact Hemisphere to find the 
authorized dealer near you. As well, Hemisphere may make available user and 
technical documentation regarding the Software. Hemisphere reserves the right to 
reduce and limit access to such support at any time.

 5. BACKUPS AND RECOVERY. Licensee shall back-up all data used, created or stored 
by the Software on a regular basis as necessary to enable proper recovery of the data 
and related systems and processes in the event of a malfunction in the Software or 
any loss or corruption of data caused by the Software. Licensee shall assume all risks 
of loss or damage for any failure to comply with the foregoing.

 6. OWNERSHIP. Hemisphere and its suppliers own all rights, title and interest in and to 
the Software and related materials, including all intellectual property rights. The 
Software is licensed to Licensee, not sold. 

 7. TRADEMARKS. "Hemisphere GPS", "Outback Guidance", "BEELINE", "Crescent", 
"Eclipse" and the associated logos are trademarks of Hemisphere. Other trademarks 
are the property of their respective owners. Licensee may not use any of these 
trademarks without the consent of their respective owners.

 8. LIMITED WARRANTY. Hemisphere warrants solely to the Licensee, subject to the 
exclusions and procedures set forth herein below, that for a period of one (1) year 
from the original date of purchase of the Product in which it is embedded (the 
"Warranty Period"), the Software, under normal use and maintenance, will conform in 
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all material respects to the documentation provided with the Software and any media 
will be free of defects in materials and workmanship. For any Update, Hemisphere 
warrants, for 90 days from performance or delivery, or for the balance of the original 
Warranty Period, whichever is greater, that the Update, under normal use and 
maintenance, will conform in all material respects to the documentation provided 
with the Update and any media will be free of defects in materials and workmanship. 
Notwithstanding the foregoing, Hemisphere does not warrant that the Software will 
meet Licensee's requirements or that its operation will be error free. 

 9. WARRANTY EXCLUSIONS. The warranty set forth in Section (LIMITED 
WARRANTY. Hemisphere warrants solely to the Licensee, subject to the exclusions 
and procedures set forth herein below, that for a period of one (1) year from the 
original date of purchase of the Product in which it is embedded (the "Warranty 
Period"), the Software, under normal use and maintenance, will conform in all 
material respects to the documentation provided with the Software and any media 
will be free of defects in materials and workmanship. For any Update, Hemisphere 
warrants, for 90 days from performance or delivery, or for the balance of the original 
Warranty Period, whichever is greater, that the Update, under normal use and 
maintenance, will conform in all material respects to the documentation provided 
with the Update and any media will be free of defects in materials and workmanship. 
Notwithstanding the foregoing, Hemisphere does not warrant that the Software will 
meet Licensee's requirements or that its operation will be error free.  will not apply to 
any deficiencies caused by (a) the Product not being used as described in the 
documentation supplied to Licensee, (b) the Software having been altered, modified 
or converted in any way by anyone other than Hemisphere approved by Hemisphere, 
(c) any malfunction of Licensee's equipment or other software, or (d) damage 
occurring in transit or due to any accident, abuse, misuse, improper installation, 
lightning (or other electrical discharge) or neglect other than that caused by 
Hemisphere. Hemisphere GPS does not warrant or guarantee the precision or 
accuracy of positions obtained when using the Software (whether standalone or 
embedded in a Product). The Product and the Software is not intended and should not 
be used as the primary means of navigation or for use in safety of life applications. 
The potential positioning and navigation accuracy obtainable with the Software as 
stated in the Product or Software documentation serves to provide only an estimate 
of achievable accuracy based on specifications provided by the US Department of 
Defense for GPS positioning and DGPS service provider performance specifications, 
where applicable. 

 10. WARRANTY DISCLAIMER. EXCEPT AS EXPRESSLY SET OUT IN THIS 
AGREEMENT, HEMISPHERE MAKES NO REPRESENTATION, WARRANTY OR 
CONDITION OF ANY KIND TO LICENSEE, WHETHER VERBAL OR WRITTEN AND 
HEREBY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES AND CONDITIONS OF 
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ANY KIND INCLUDING FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, 
ACCURACY, RELIABILITY OR THAT THE USE OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE AND HEREBY DISCLAIMS ALL 
REPRESENTATIONS, WARRANTIES AND CONDITIONS ARISING AS A RESULT OF 
CUSTOM, USAGE OR TRADE AND THOSE ARISING UNDER STATUTE.

 11. LIMITS ON WARRANTY DISCLAIMER. Some jurisdictions do not allow the 
exclusion of implied warranties or conditions, so some of the above exclusions may 
not apply to Licensee. In that case, any implied warranties or conditions which would 
then otherwise arise will be limited in duration to ninety (90) days from the date of the 
license of the Software or the purchase of the Product. The warranties given herein 
give Licensee specific legal rights and Licensee may have other rights which may 
vary from jurisdiction to jurisdiction.

 12. CHANGE TO WARRANTY. No employee or agent of Hemisphere is authorized to 
change the warranty provided or the limitation or disclaimer of warranty provisions. 
All such changes will only be effective if pursuant to a separate agreement signed by 
senior officers of the respective parties. 

 13. WARRANTY CLAIM. In the event Licensee has a warranty claim Licensee must first 
check for and install all Updates that are made available. The warranty will not 
otherwise be honored. Proof of purchase may be required. Hemisphere does not 
honor claims asserted after the end of the Warranty Period.

 14. LICENSEE REMEDIES. In all cases which involve a failure of the Software to 
conform in any material respect to the documentation during the Warranty Period or 
a breach of a warranty, Hemisphere's sole obligation and liability, and Licensee's sole 
and exclusive remedy, is for Hemisphere, at Hemisphere's option, to (a) repair the 
Software, (b) replace the Software with software conforming to the documentation, or 
(c) if Hemisphere is unable, on a reasonable commercial basis, to repair the Software 
or to replace the Software with conforming software within ninety (90) days, to 
terminate this Agreement and thereafter Licensee shall cease using the Software. 
Hemisphere will also issue a refund for the price paid by Licensee less an amount on 
account of amortization, calculated on a straight-line basis over a deemed useful life 
of three (3) years. 

 15. LIMITATION OF LIABILITY. IN NO EVENT WILL HEMISPHERE BE LIABLE TO 
LICENSEE FOR ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL OR INDIRECT 
DAMAGES INCLUDING ARISING IN RELATION TO ANY LOSS OF DATA, INCOME, 
REVENUE, GOODWILL OR ANTICIPATED SAVINGS EVEN IF HEMISPHERE HAS BEEN 
INFORMED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE. FURTHER, IN NO 
EVENT WILL HEMISPHERE'S TOTAL CUMULATIVE LIABILITY HEREUNDER, FROM 
ALL CAUSES OF ACTION OF ANY KIND, EXCEED THE TOTAL AMOUNT PAID BY 
LICENSEE TO HEMISPHERE TO PURCHASE THE PRODUCT.   THIS LIMITATION AND 
77



End User License Agreement
EXCLUSION APPLIES IRRESPECTIVE OF THE CAUSE OF ACTION, INCLUDING BUT 
NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, STRICT LIABILITY, TORT, 
BREACH OF WARRANTY, MISREPRESENTATION OR ANY OTHER LEGAL THEORY 
AND WILL SURVIVE A FUNDAMENTAL BREACH.

 16. LIMITS ON LIMITATION OF LIABILITY. Some jurisdictions do not allow for the 
limitation or exclusion of liability for incidental or consequential damages, so the 
above limitation or exclusion may not apply to Licensee and Licensee may also have 
other legal rights which may vary from jurisdiction to jurisdiction.

 17. BASIS OF BARGAIN. Licensee agrees and acknowledges that Hemisphere has set 
its prices and the parties have entered into this Agreement in reliance on the limited 
warranties, warranty disclaimers and limitations of liability set forth herein, that the 
same reflect an agreed-to allocation of risk between the parties (including the risk that 
a remedy may fail of its essential purpose and cause consequential loss), and that the 
same forms an essential basis of the bargain between the parties. Licensee agrees 
and acknowledges that Hemisphere would not have been able to sell the Product at 
the amount charged on an economic basis without such limitations. 

 18. PROPRIETARY RIGHTS INDEMNITY. Hemisphere shall indemnify, defend and hold 
harmless Licensee from and against any and all actions, claims, demands, 
proceedings, liabilities, direct damages, judgments, settlements, fines, penalties, 
costs and expenses, including royalties and attorneys' fees and related costs, in 
connection with or arising out of any actual infringement of any third party patent, 
copyright or other intellectual property right by the Software or by its use, in 
accordance with this Agreement and documentation, PROVIDED THAT: (a) 
Hemisphere has the right to assume full control over any action, claim, demand or 
proceeding, (b) Licensee shall promptly notify Hemisphere of any such action, claim, 
demand, or proceeding, and (c) Licensee shall give Hemisphere such reasonable 
assistance and tangible material as is reasonably available to Licensee for the 
defense of the action, claim, demand or proceeding. Licensee shall not settle or 
compromise any of same for which Hemisphere has agreed to assume responsibility 
without Hemisphere's prior written consent. Licensee may, at its sole cost and 
expense, retain separate counsel from the counsel utilized or retained by 
Hemisphere.

 19. INFRINGEMENT. If use of the Software may be enjoined due to a claim of 
infringement by a third party then, at its sole discretion and expense, Hemisphere 
may do one of the following: (a) negotiate a license or other agreement so that the 
Product is no longer subject to such a potential claim, (b) modify the Product so that it 
becomes non-infringing, provided such modification can be accomplished without 
materially affecting the performance and functionality of the Product, (c) replace the 
Software, or the Product, with non-infringing software, or product, of equal or better 
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performance and quality, or (d) if none of the foregoing can be done on a 
commercially reasonable basis, terminate this license and Licensee shall stop using 
the Product and Hemisphere shall refund the price paid by Licensee less an amount 
on account of amortization, calculated on a straight-line basis over a deemed useful 
life of three (3) years. 

 20. The foregoing sets out the entire liability of Hemisphere and the sole obligations of 
Hemisphere to Licensee in respect of any claim that the Software or its use infringes 
any third party rights

 21. INDEMNIFICATION. Except in relation to an infringement action, Licensee shall 
indemnify and hold Hemisphere harmless from any and all claims, damages, losses, 
liabilities, costs and expenses (including reasonable fees of lawyers and other 
professionals) arising out of or in connection with Licensee's use of the Product, 
whether direct or indirect, including without limiting the foregoing, loss of data, loss 
of profit or business interruption. 

 22. TERMINATION. Licensee may terminate this Agreement at any time without cause. 
Hemisphere may terminate this Agreement on 30 days notice to Licensee if Licensee 
fails to materially comply with each provision of this Agreement unless such default 
is cured within the 30 days. Any such termination by a party shall be in addition to 
and without prejudice to such rights and remedies as may be available, including 
injunction and other equitable remedies. Upon receipt by Licensee of written notice 
of termination from Hemisphere or termination by Licensee, Licensee shall at the end 
of any notice period (a) cease using the Software; and (b) return to Hemisphere (or 
destroy and provide a certificate of a Senior Officer attesting to such destruction) the 
Software and all related material and any magnetic or optical media provided to 
Licensee. The provisions of Sections OWNERSHIP. Hemisphere and its suppliers own 
all rights, title and interest in and to the Software and related materials, including all 
intellectual property rights. The Software is licensed to Licensee, not sold. , 
TRADEMARKS. "Hemisphere GPS", "Outback Guidance", "BEELINE", "Crescent", 
"Eclipse" and the associated logos are trademarks of Hemisphere. Other trademarks 
are the property of their respective owners. Licensee may not use any of these 
trademarks without the consent of their respective owners., LIMITED WARRANTY. 
Hemisphere warrants solely to the Licensee, subject to the exclusions and procedures 
set forth herein below, that for a period of one (1) year from the original date of 
purchase of the Product in which it is embedded (the "Warranty Period"), the 
Software, under normal use and maintenance, will conform in all material respects to 
the documentation provided with the Software and any media will be free of defects 
in materials and workmanship. For any Update, Hemisphere warrants, for 90 days 
from performance or delivery, or for the balance of the original Warranty Period, 
whichever is greater, that the Update, under normal use and maintenance, will 
conform in all material respects to the documentation provided with the Update and 
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any media will be free of defects in materials and workmanship. Notwithstanding the 
foregoing, Hemisphere does not warrant that the Software will meet Licensee's 
requirements or that its operation will be error free. , WARRANTY EXCLUSIONS. The 
warranty set forth in Section (LIMITED WARRANTY. Hemisphere warrants solely to 
the Licensee, subject to the exclusions and procedures set forth herein below, that for 
a period of one (1) year from the original date of purchase of the Product in which it is 
embedded (the "Warranty Period"), the Software, under normal use and maintenance, 
will conform in all material respects to the documentation provided with the Software 
and any media will be free of defects in materials and workmanship. For any Update, 
Hemisphere warrants, for 90 days from performance or delivery, or for the balance of 
the original Warranty Period, whichever is greater, that the Update, under normal use 
and maintenance, will conform in all material respects to the documentation 
provided with the Update and any media will be free of defects in materials and 
workmanship. Notwithstanding the foregoing, Hemisphere does not warrant that the 
Software will meet Licensee's requirements or that its operation will be error free.  
will not apply to any deficiencies caused by (a) the Product not being used as 
described in the documentation supplied to Licensee, (b) the Software having been 
altered, modified or converted in any way by anyone other than Hemisphere 
approved by Hemisphere, (c) any malfunction of Licensee's equipment or other 
software, or (d) damage occurring in transit or due to any accident, abuse, misuse, 
improper installation, lightning (or other electrical discharge) or neglect other than 
that caused by Hemisphere. Hemisphere GPS does not warrant or guarantee the 
precision or accuracy of positions obtained when using the Software (whether 
standalone or embedded in a Product). The Product and the Software is not intended 
and should not be used as the primary means of navigation or for use in safety of life 
applications. The potential positioning and navigation accuracy obtainable with the 
Software as stated in the Product or Software documentation serves to provide only 
an estimate of achievable accuracy based on specifications provided by the US 
Department of Defense for GPS positioning and DGPS service provider performance 
specifications, where applicable. , WARRANTY DISCLAIMER. EXCEPT AS EXPRESSLY 
SET OUT IN THIS AGREEMENT, HEMISPHERE MAKES NO REPRESENTATION, 
WARRANTY OR CONDITION OF ANY KIND TO LICENSEE, WHETHER VERBAL OR 
WRITTEN AND HEREBY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES AND 
CONDITIONS OF ANY KIND INCLUDING FITNESS FOR A PARTICULAR PURPOSE, 
MERCHANTABILITY, ACCURACY, RELIABILITY OR THAT THE USE OF THE SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR-FREE AND HEREBY DISCLAIMS ALL 
REPRESENTATIONS, WARRANTIES AND CONDITIONS ARISING AS A RESULT OF 
CUSTOM, USAGE OR TRADE AND THOSE ARISING UNDER STATUTE., LIMITATION 
OF LIABILITY. IN NO EVENT WILL HEMISPHERE BE LIABLE TO LICENSEE FOR ANY 
INCIDENTAL, CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES INCLUDING 
ARISING IN RELATION TO ANY LOSS OF DATA, INCOME, REVENUE, GOODWILL OR 
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ANTICIPATED SAVINGS EVEN IF HEMISPHERE HAS BEEN INFORMED OF THE 
POSSIBILITY OF SUCH LOSS OR DAMAGE. FURTHER, IN NO EVENT WILL 
HEMISPHERE'S TOTAL CUMULATIVE LIABILITY HEREUNDER, FROM ALL CAUSES 
OF ACTION OF ANY KIND, EXCEED THE TOTAL AMOUNT PAID BY LICENSEE TO 
HEMISPHERE TO PURCHASE THE PRODUCT. THIS LIMITATION AND EXCLUSION 
APPLIES IRRESPECTIVE OF THE CAUSE OF ACTION, INCLUDING BUT NOT LIMITED 
TO BREACH OF CONTRACT, NEGLIGENCE, STRICT LIABILITY, TORT, BREACH OF 
WARRANTY, MISREPRESENTATION OR ANY OTHER LEGAL THEORY AND WILL 
SURVIVE A FUNDAMENTAL BREACH., INDEMNIFICATION. Except in relation to an 
infringement action, Licensee shall indemnify and hold Hemisphere harmless from 
any and all claims, damages, losses, liabilities, costs and expenses (including 
reasonable fees of lawyers and other professionals) arising out of or in connection 
with Licensee's use of the Product, whether direct or indirect, including without 
limiting the foregoing, loss of data, loss of profit or business interruption. , FORUM 
FOR DISPUTES. The parties agree that the courts located in Calgary, Alberta, Canada 
and the courts of appeal there from will have exclusive jurisdiction to resolve any 
disputes between Licensee and Hemisphere concerning this Agreement or Licensee's 
use or inability to use the Software and the parties hereby irrevocably agree to attorn 
to the jurisdiction of those courts. Notwithstanding the foregoing, either party may 
apply to any court of competent jurisdiction for injunctive relief.  and APPLICABLE 
LAW. This Agreement shall be governed by the laws of the Province of Alberta, 
Canada, exclusive of any of its choice of law and conflicts of law jurisprudence.  
herein shall survive the expiry or termination of this Agreement for any reason.

 23. EXPORT RESTRICTIONS. Licensee agrees that Licensee will comply with all export 
control legislation of Canada, the United States, Australia and any other applicable 
country's laws and regulations, whether under the Arms Export Control Act, the 
International Traffic in Arms Regulations, the Export Administration Regulations, the 
regulations of the United States Departments of Commerce, State, and Treasury, or 
otherwise as well as the export control legislation of all other countries. 

 24. PRODUCT COMPONENTS. The Product may contain third party components. 
Those third party components may be subject to additional terms and conditions. 
Licensee is required to agree to those terms and conditions in order to use the 
Product. 

 25. FORCE MAJEURE EVENT. Neither party will have the right to claim damages as a 
result of the other's inability to perform or any delay in performance due to 
unforeseeable circumstances beyond its reasonable control, such as labor disputes, 
strikes, lockouts, war, riot, insurrection, epidemic, Internet virus attack, Internet 
failure, supplier failure, act of God, or governmental action not the fault of the non-
performing party. 
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 26. FORUM FOR DISPUTES. The parties agree that the courts located in Calgary, 
Alberta, Canada and the courts of appeal there from will have exclusive jurisdiction to 
resolve any disputes between Licensee and Hemisphere concerning this Agreement 
or Licensee's use or inability to use the Software and the parties hereby irrevocably 
agree to attorn to the jurisdiction of those courts. Notwithstanding the foregoing, 
either party may apply to any court of competent jurisdiction for injunctive relief. 

 27. APPLICABLE LAW. This Agreement shall be governed by the laws of the Province of 
Alberta, Canada, exclusive of any of its choice of law and conflicts of law 
jurisprudence. 

 28. CISG. The United Nations Convention on Contracts for the International Sale of 
Goods will not apply to this Agreement or any transaction hereunder.

 29. GENERAL. This is the entire agreement between Licensee and Hemisphere relating 
to the Product and Licensee's use of the same, and supersedes all prior, collateral or 
contemporaneous oral or written representations, warranties or agreements 
regarding the same. No amendment to or modification of this Agreement will be 
binding unless in writing and signed by duly authorized representatives of the 
parties. Any and all terms and conditions set out in any correspondence between the 
parties or set out in a purchase order which are different from or in addition to the 
terms and conditions set forth herein, shall have no application and no written notice 
of same shall be required. In the event that one or more of the provisions of this 
Agreement is found to be illegal or unenforceable, this Agreement shall not be 
rendered inoperative but the remaining provisions shall continue in full force and 
effect. 
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